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1. Introduction
1.1. General remarks
First of all, we would like to congratulate you to the purchase of a
high quality DEDITEC product.
Our products are being developed by our engineers according to
quality requirements of high standard. Already during design and
development we take care that our products have -besides
quality- a long availability and an optimal flexibility.
Modular design
The modular design of our products reduces the time and the
cost of development. Therefor we can offer you high quality
products at a competitive price.
We ensure a long delivery availability!
If semiconductors are no longer available, we can react faster.
With us, usually only modules have to be redesigned and not the
entire product. This increases the delivery availability.
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1.2. Customer satisfaction
Our philosophy: a content customer will come again. Therefor
customer satisfaction is in first place for us.
If by any chance, you are not content with the performance of our
product, please contact us by phone or mail immediately.
We take care of the problem!
1.3. Customer response
Our best products are co-developments together with our
customers. Therefor we are thankful for comments and
suggestions.
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2. Hardware description
2.1. Quick installation
2.1.1. Step 1 - Installation of the software and driver

Now install the driver DELIB library with the file "delib_install.exe"
from the supplied DEDITEC-Driver CD.
These can be found in the "\zip\DELIB\delib_install.exe" on the
DEDITEC-Driver CD.
Note: On our website www.deditec.de you can always find the
latest DELIB driver version.
2.1.2. Step 2 - Connecting of the module

Connect the ETH-RELAIS-8 or the ETH-OPTOIN-8 with a ethernet
cable with your network or PC.
2.1.3. Step 3 - Testing the connection and the module

In the Start menu, see "Start -> All Programs -> DEDITEC -> DELIB > Sample Programs" you will find some example programs to test
your module.
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2.1.4. DIP-Switches

You can configure DHCP- and EEPROM settings on the module
directly via DIP-Switches.

Attention: All changes to the DIP switches are only applied after
disconnection and restoration of the voltage supply.
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DIP
Mode / Description
Switch 1
ON

DHCP is active
The network settings IP, subnet mask, DNS-Domain
and gateway will be received from a DHCP Server.

OFF

DHCP is not active
The network settings ip, subnet mask, DNS-Domain
and gateway from the module (EEPROM) itself will
be used.
With the DELIB-Configuration Utility those settings
can be edited and saved in to the EEPROM of the
module.

DIP
Mode / Description
Switch 2
ON

EEPROM is write protected
If the write protection is on, no settings can be
configured via the DELIB-Configuration Utility.

OFF

EEPROM write protection is off
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DIP
Mode / Description
Switch 3
ON

The settings from the EEPROM will be ignored on
module start. The modul will start with factory
settings. The settings which will be ignored are the
IP-address, gateway, subnet mask and DHCP.
Factory settings:
IP: 192.168.1.1
Subnet mask: 255.255.255.0
Gateway: 192.168.1.254
DHCP: Off
The settings in the EEPROM will not be changed.

OFF

The module will start with the settings from the
EEPROM

DIP
Mode / Description
Switch 4
ON

Modul will start normally.

OFF

Only for service.
The module will stay in bootloader mode and won't
start the firmware. All settings in the EEPROM will
not be changed.
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2.2. ETH-RELAIS-8
2.2.1. Technical data

Ethernet-Interface 100/10Mbit
Access time from the PC to the module: 0.7 ms
(Calculated with 1000 accesses to the module via the
DELIB driver library with the command DapiDoSet32)
Power supply: External 12-24V DC
8 Relays outputs (36V, 1A, 10W, make contact)
Max. switching voltage: 36V DC
Max. switching current: 0,5A
Max. switching power: 10W
Max. transport current: 1,25A
Isolation : 5TOhm
Switching time: 0,5ms
Fall time: 0,1ms

Hardware description | Seite

16

Timeout protection
-Easy and uncomplicated setting of the
timeout protection function via software
-Automatic activation of the timeout protection function
can be
timeout protection function
timeout (between 0.1 seconds and 6553 seconds).
seconds)
-In the timeout case, digital outputs can be activated,
deactivated or left unchanged
-3 different timeout modes: "normal", "auto reactive" and
"secure output
and "secure output" for different
procedures in case of a timeout event
2 Control-LEDs (Status, Interface activity)
8 LED Output-LEDs, one for each output
Dimensions: 77 x 67,5 x 55 mm (L x B x H)
Operation temperature: 10°C .. 50°C
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2.2.2. Product pictures

ETH-RELAIS-8
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2.2.3. Overview screen
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2.2.4. Power supply

The input voltage range can be selected between + 7V and + 24V
DC. The connection can be made using a standard plug-in power
supply unit with a 1A current output. A suitable connector is
included with every module.
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2.2.5. Pin assignment

2.2.5.1. Pin assignment J1

Pin

Description

1

Output Channel 1

2

Output Channel 1

3

Output Channel 2

4

Output Channel 2

5

Output Channel 3

6

Output Channel 3

7

Output Channel 4

8

Output Channel 4
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2.2.5.2. Pin assignment J2

Pin

Description

9

Output Channel 5

10

Output Channel 5

11

Output Channel 6

12

Output Channel 6

13

Output Channel 7

14

Output Channel 7

15

Output Channel 8

16

Output Channel 8
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2.2.6. Outputs

2.2.6.1. Relay outputs

The relays are able to switch voltages up to 36V. The max.
current is 1A at a max. power of 15W.
Additionally, the relays provide a safe electrical isolation of the
module to the connected equipment.
2.2.6.2. Timeout protection

The timeout protection offers the possibility to switch the
outputs of the module independently.
It can be determined which channel is to be switched on or off.
This happens if no data is received on the module in a previously
defined time window.
Reasons can be a line interruption, system crash, power failure
etc.
The triggering of the timeout protection is signaled by the output
timeout LED.
This function can, among other things, prevent control damage
and overloads on connected systems.
Some modules are only able to switch off all outputs.
Please look at our overview table for more information:
DELIB Overview Table
See chapter: Output timeout management
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2.2.6.3. Visual control of the outputs (depends of module)

The state of each output is directly signalized by a separate LED.
This simplifies to detect and rectify wiring errors, because the
signals on the cables are directly observable.
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2.3. ETH-OPTOIN-8
2.3.1. Technical data

Ethernet-Interface 100/10Mbit
Access time from the PC to the module: 0.7 ms
(Calculated with 1000 accesses to the module via the
DELIB driver library with the command DapiDoSet32)
Power supply: External 12-24V DC
8 opto-coupler inputs
24V AC switching voltage (optional 15V, 12V and 5V are
available)
16 Bit-Counter for each input
Detection of pulses between two selection cycles
Galvanically isolated using opto-couplers
Variable input voltage range min 5V, max 30V AC (standard: 1530V)
Logging of impulses between 2 read out cycles
Control-LED LED for 5V power supply
Dimensions: 77 x 67,5 x 55 mm (L x W x H)
Operating temperature: 10°C .. 50°C

Hardware description | Seite

25

2.3.2. Product pictures

ETH-RELAIS-8
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2.3.3. Overview screen
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2.3.4. Power supply

The input voltage range can be selected between + 7V and + 24V
DC. The connection can be made using a standard plug-in power
supply unit with a 1A current output. A suitable connector is
included with every module.
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2.3.5. Pin assignment

2.3.5.1. Pin assignment J1

Pin

Description

1

Input Channel 1 +

2

Input Channel 1 -

3

Input Channel 2 +

4

Input Channel 2 -

5

Input Channel 3 +

6

Input Channel 3 -

7

Input Channel 4 +

8

Input Channel 4 -
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2.3.5.2. Pin assignment J2

Pin

Description

9

Input Channel 5 +

10

Input Channel 5 -

11

Input Channel 6 +

12

Input Channel 6 -

13

Input Channel 7 +

14

Input Channel 7 -

15

Input Channel 8 +

16

Input Channel 8 -
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2.3.6. Inputs

2.3.6.1. Registering short input pulses

Short input pulses between to read-out cycles are registered
through an additional logic and can be separately read-out.

2.3.6.2. Galvanically decouppled through optocouplers

AC input opto-couplers provide a galvanic isolation of the module
towards the connected equipment. They also provide a safe
connection to the module for reverse currents and high voltage
peaks.

2.3.6.3. Visual control of the inputs (depends of module)

The state of each input is directly signalized by a separate LED.
This simplifies to detect and rectify wiring errors, because the
signals on the cables are directly observable.
Note: Only available for the ETH-RELAIS-8 and ETH-RELAIS-8_B
module

Hardware description | Seite

31

2.3.6.4. Digital input filter

The digital input filter offers the possibility to switch channels
only when the signal is present for a certain time.
The time itself can be set to a value between 0..255 ms.
If a value of 0 ms is selected, the filter is not active.
Here you can find a detailed list of all modules, that support this
feature:
DELIB Overview Table
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The following is a graphic that illustrates the point:
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Hardware

III
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3. Hardware
3.1. LED blinking behavior
Explanation

1.) Boot process
The boot process starts immediately after the power
supply is plugged in.

The boot process sequence is run through once.
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2.) Application or boot loader
2.1 Application
The boot process has been successfully completed and the
product is in the application. The product is now ready for use.

The status LED lights up for 5 seconds and goes out for about
300ms. The application sequence repeats itself.
At modules with Ethernet interface (not RO-ETH and RO-CPU-800)
the status LED shows additional information.
Status LED goes out once: Static IP is configured
Status LED goes out six times: Module cannot establish Ethernet
connection
DHCP Status
When the module is started:
Status LED goes out four times: Module receives IP address via
DHCP.
After receiving the IP address:
Status LED goes out twice: DHCP is set via DIP switch
Status LED goes out three times: DHCP is not set via DIP switch
but via EEPROM

Hardware | Seite

36

2.2. Bootloader
The product is in the boot loader after booting. This indicates an
error in the firmware.
Updating the firmware can fix the problem in most cases.
The latest firmware versions can be downloaded via the DTFlasher ( -> see Performing a firmware update)

The status LED lights up for 2 seconds and goes out for about
300ms. The bootloader sequence repeats.
3.) Bootloader forced
The product can be forced into the bootloader by means of the
DIP switches.
The bootloader is for service purposes only.

The status LED flashes alternately for 2 seconds. This sequence
is only run through once.
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3.2. DIP-Switches
Some settings can be easily configured using DIP switches. The
DHCP and EEPROM settings can be configured.

Attention: All changes to the DIP switches are only applied
after disconnection and restoration of the voltage supply.
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DIP

Modus / Erklärung

Switch 1
ON

DHCP is activated
The network settings (IP, subnet mask, DNS
domain as well as gateway) are obtained from your
network via a DHCP server.

OFF

DHCP deactivated
The network settings (IP, subnet mask, DNS
domain as well as gateway) are used from the
EEPROM of the module.
With the help of the DELIB configuration utility
these settings can be edited and stored in the
EEPROM of the module.
See chapter: DELIB configuration utility
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DIP

Modus / Explanation

Switch 2
ON

EEPROM Write protection enabled
If the write protection is active, no configuration of
the network settings can be made via the DELIB
Configuration Utility.

OFF

EEPROM Write protection disabled

DIP

Modus / Explanation

Switch 3
ON

The module starts with the parameters stored in
the EEPROM.

OFF

The values stored in the EEPROM (IP address,
gateway, subnet mask, DHCP) are ignored when the
module is started.
The module starts with the factory settings.
Factory settings:
IP: 192.168.1.1
Port: 9912
Subnetzmaske: 255.255.255.0
Gateway: 192.168.1.254
DHCP: Off
The values stored in the EEPROM are not changed.
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DIP

Modus / Explanation

Switch 4
ON

Modul starts normally

OFF

For SERVICE purposes only.
Application is not started. Module remains forcibly
in the bootloader.
All settings stored in the EEPROM are retained.
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Software
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4. Software
4.1. Using our products

4.1.1. Access via the DELIB driver library

The DELIB driver library contains the DELIB API and various
programs for the configuration test of our products.
The API gives you access to all the functions you need to
communicate with our products.
In the chapter DELIB API Reference you will find all the functions
of our driver library explained and provided with application
examples.
4.1.2. Access via provided test programs

With our DELIB Module Demo, you can test our control and
control technology products for functionality without any major
configuration effort.
For detailed information see chapter DELIB Module Demo
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4.1.3. Access via protocol

The protocol for the activation of our products is open source. So
you are able to use our products on systems without Windows or
Linux.
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4.1.4. DELIB CLI (command-line interface) for Windows

In some programming languages (like PHP), you can't include
DLLs, therefore is an extra console command, which you can
directly call out of the program (with appropriate parameters).
You can find this command after installation of the DELIB
driverlibrary
in
the
directory
C:
\Programme\DEDITEC\DELIB\Programs\Console.
You can find the DELIB CLI Command for Windows after
Installation of the DELIB driverlibrary in the directory C:
\Programme\DEDITEC\DELIB\programs\cli\ .
The DELIB CLI Command for Linux is located in the directory "/
delib-cli/, after unzipping the ZIP-Archiv "delib-linux".
Definition
delib_cli command channel [value | unit ["nounit"] ]

Note: The parameters are separated by spaces.
These commands and parameters are not case sensitive.
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Parameter
command channel
di1

value

nounit

0, 1, 2, ...

di8
di16

unit

0, 8, 16, ...

-

hex

nounit

hex

nounit

-

-

hex, volt,
mA

nounit

-

-

di24
ff

0, 32, ...

-

do1

0, 1, 2, ...

0/1 (1-bit command)

do8

8bit
val
ue

do16

16bit (Bit 0 for channel 1,
val Bit 1 for channel 2, ...)
ue

0, 8, 16, ...

24bit
val
ue

do24

ai

ao

0, 1, 2, ...

-

0, 1, 2, ...

integer or hexadecimal
number
(starting with 0x).
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Return-value
Read the state of the digital inputs
In combination with the parameter unit "hex" the state will be
read as hex
Read the state of the FlipFlops of the digital inputs
In combination with the parameter unit "hex" the state will be
read as hex
Read the state of the analog inputs
In combination with the parameter unit "hex" the state will be
read as hex
In combination with the parameter unit "volt" the state will be
read as voltage
in combination with the parameter unit "mA" the state will be read
as current
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4.1.4.1. Customization of the DELIB CLI

Before the first use of the CLI DELIB the "delib_cli.cfg" must be
edited with a text editor.
Configuration on Windows / Linux
On windows machines you can find the "delib_cli.cfg" after the
installation of the DELIB Driver library in this directory "C:
\Programme\DEDITEC\DELIB\programs\cli\".

Content of the "delib_cli.cfg":
moduleID=14;
moduleNR=0;
RO-ETH_ipAddress=192.168.1.11;

moduleID
The moduleID is the corresponding number of the desired
module and can be read in the "delib.h"
On windows you can find the "delib.h" in this directory: "C:
\Programme\DEDITEC\DELIB\include\".
moduleNR
The moduleNR can be set in the DELIB Configuration Utility.
This number is needed to identify identical hardware.
The default value is 0.
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RO-ETH_ipAddress
This entry is only needed when modules with ethernet interface
are being used.
The IP-Address can be changed with the DELIB Configuration
Utility and the Webinterface of the module.
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4.1.4.2. DELIB CLI samples
Digital Outputs
delib_cli DO1 17 1
-> digital output 18 will be switched on
delib_cli DO1 3 0
-> digital output 4 will be switched on
delib_cli DO8 0 255
-> digital outputs 1-8 will be switched on
delib_cli DO16 0 0
-> digital outputs 1-16 will be switched off
delib_cli DO16 16 65535
-> digital outputs 17-32 will be switched on
delib_cli DO32 0 4294967295
-> digital outputs 1-32 will be switched on
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Digital Inputs
delib_cli DI1 3
Example return value: 1
-> read the state of digital input 4.
delib_cli DI8 0 hex
Example return value: 0xC8
(channel 4, 7 and 8 have a high signal)
-> read the states of digital inputs 1-8 as hex
delib_cli DI16 0 hex
Example return value: 0xE 0C0
(channel 7, 8, 14 ,15 and 16 have a high signal)
-> read the states of digital inputs 1-16 as hex
delib_cli DI32 0 hex
Example return value: 0xC0000003
(channel 1, 2, 31 and 32 have a high signal)
-> read the states of digital inputs 1-32 as hex
Alternatively the argument "nounit" can be appended
delib_cli DI8 0 hex nounit
Example return value: FF
(channel 1-8 have a high signal)
-> read the states of digital inputs 1-8 as hex
delib_cli FF 0
Example return value: 192
(channel 7 and 8 have a change of state)
-> read the FlipFlops of the digital inputs 1-32
delib_cli FF 32
Example return value: 65535
(channel 33 and 64 have a change of state)
-> read the FlipFlops of the digital inputs 33-64
delib_cli FF 0 hex
Example return value: 0xD 00
(channel 9, 11 and 12 have a change of state)
-> read the FlipFlops of the digital inputs 1-32 as hex
delib_cli FF 32 hex
Example return value: 0x3
(channel 33 and 34 have a change of state)
-> read the FlipFlops of the digital inputs 33-64 as hex
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Analog Outputs
delib_cli AO 7 4711
->analog output 8 will be set to the decimal value 4711
delib_cli AO 6 0x4711
->analog output 7 will be set to the hexadecimal value 0x4711
delib_cli AO 7 3.7V
-> the voltage of analog output 8 will be set to 3,7 Volt
(the comma "," and the dot "." can be used for decimal separation)
delib_cli AO 7 13.3mA
-> the current of analog output 8 will be set to 13,3 mA
(the comma "," and the dot "." can be used for decimal separation)

Analog Inputs
delib_cli AI 2
Example of a return value: 1234
-> reads the value of analog input 3 as decimal
delib_cli AI 2 hex
Example of a return value: 0x1FA
-> reads the value of analog input 3 as hexadecimal
delib_cli AI 2 V
Example of a return value: 12.500000V
-> reads the voltage of analog input 3 as point number
delib_cli AI 2 mA
Example of a return value: 20.551600mA
-> reads the current of analog input 3 as point number
Alternatively you can append the argument "nounit"
delib_cli AI 3 hex nounit
Example of a return value: 1FA
-> reads the value of analog input 4 as hexadecimal
delib_cli AI 3 V nounit
Example of a return value: 12.500000
-> reads the voltage of analog input 4 as point number
delib_cli AI 3 mA nounit
Example of a return value: 20.551600
-> reads the current of analog input 4 as point number
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4.1.5. Access via graphical applications

4.1.5.1. LabVIEW

Our DELIB API can be imported and used in LabVIEW. All products
using our DELIB API are therefore compatible with LabVIEW.
The following chapter shows you how to integrate the DELIB API
into LabVIEW: Integration of the DELIB in LabVIEW
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4.1.5.2. ProfiLab

The ProfiLab software from Abacom supports a large number of
our control technology products.
Link to the manufacturer: http://www.abacom-online.de/html/
profilab-expert.html
The following I / Os are supported.
Digital in-/outputs
- Relays
- MOSFET
- Optocoupler
- Bistable relays
Analog in-/outputs
- Analog to digital converter
- Digital to analog converter
TTL-I/Os
- 8 / 32 / 64 TTL-channels
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4.1.5.3. Licht24 Pro

The Licht24 Pro software from bksoft also supports a large
number of our products.
For more information,
licht24pro.htm

please

visit:

http://www.bksoft.de/
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4.1.6. Integration of the DELIB in programming languages

4.1.6.1. Integration of the DELIB in Visual-C/C++

To facilitate references to the DELIB include and the DELIB-Lib
directory, environment variables are defined when the DELIB is
installed.
DELIB_LIB = C:\Programme\DEDITEC\DELIB\lib
DELIB_INCLUDE = C:\Programme\DEDITEC\DELIB\include
These are listed below in the project settings of the compiler.
Visual C / C ++ Start and open in the menu "Project -> Settings".
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DELIB.H entry in the Visual-C/C++ Project configurations
Under the tab "C/C++" choose the "Kategorie" Präprozessor and
enter on "Zusätzliche Include Verzeichnisse" "$(DELIB_INCLUDE)".
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DELIB.LIB entry in the Visual-C/C++ Project configurations
Under the tab "Linker" extend the existing line in "Zusätzliche
Include Verzeichnisse" with the ending "$(DELIB_LIB)\delib.lib"
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4.1.6.2. Integration of the DELIB in Visual-C/C++ (Visual Studio 2015)

To facilitate references to the DELIB include and the DELIB-Lib
directory, environment variables are defined when the DELIB is
installed.
32 bit DELIB installation
DELIB_LIB = C:\Programme\DEDITEC\DELIB\lib
DELIB_INCLUDE = C:\Programme\DEDITEC\DELIB\include
64 Bit DELIB Installation
DELIB64_LIB = C:\Programme\DEDITEC\DELIB64\lib
DELIB64_INCLUDE = C:\Programme\DEDITEC\DELIB64\include
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These are listed below in the project settings of the compiler.
Visual C / C ++ Start and open in the menu "Project -> Properties".
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DELIB.H entry in the Visual-C/C++ Project settings
In the tab "C/C++" choose the general options and enter in
additional include directory "$(DELIB_INCLUDE)".
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DELIB.LIB entry in the Visual-C/C++ project settings
In the tab "Linker" choose the general options and enter in the
additional library directory "$(DELIB_LIB)\delib.lib"
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4.1.6.3. Integration of the DELIB in Visual-C#

The required file for Visual C # is located in the directory
C:\Programme\DEDITEC\DELIB\include.
Visual C # and choose "Project -> Add existing element" in the
directory C: \ Program Files \ DEDITEC \ DELIB \ include \ to open
the delib.cs file for import.

Add the following reference in your program:
using DeLib;
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4.1.6.4. Integration of the DELIB in Delphi

Description of the "delib.pas" integration in Delphi
You can find the needed files for Delphi in the directory C:
\Programme\DEDITEC\DELIB\include\delib.pas.
Start Delphi and open via menu "Projekt -> dem Projekt
hinzufügen" the file "delib.pas" to import.
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4.1.6.5. Integration of the DELIB in Visual-Basic (VB)

Description of the "delib.bas" integration in Visual Basic
You can find the needed files for VB in the directory C:
\Programme\DEDITEC\DELIB\include\delib.bas.
Start Visual Basic and open via menu "Projekt -> Datei
hinzufügen..." the file "delibi.bas" to import.
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4.1.6.6. Integration of the DELIB in Visual-Basic.NET (VB.NET)

Description of the DELIB integration in VB.NET
You can find the needed files for VB.NET in the directory C:
\Programme\DEDITEC\DELIB\Include\delib.vb. Start VB.NET and
open via menu "Projekt -> Vorhandes Element hinzufügen" in the
directory C:\Programme\DEDITEC\DELIB\Include\ the file "delib.
vb" to import.
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4.1.6.7. Integration of the DELIB in MS-Office (VBA)

Description of the "delib.bas" integration in Visual Basic
for Applications
You can find the needed files for VBA in the directory C:
\Programme\DEDITEC\DELIB\include\delib.bas.
Start Microsoft Excel and open via menu "Extras -> Makro ->
Visual Basic Editor".
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Creation of UserForm
Create a new UserForm via menu "Einfügen -> UserForm". In the
top left-hand corner of the project manager right click on
"UserForm -> Datei importieren". Open in the directory C:
\Programme\DEDITEC\DELIB\include the file "delib.bas" to
import.
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4.1.6.8. Integration of the DELIB in LabVIEW

4.1.6.8.1. I nt egrat ion of t he D E LI B in LabVI E W

The LabVIEW-Sampleprogram "Deditec_Modul_Control.vi" is not a
EXE-File and you need to execute this file the LabVIEW
development environment.
Description of the delib.dll integration in LabVIEW Version
11
- You can find the needed files for LabVIEW in the directorys
"C:\Windows\System32\delib.dll"
and
\Programme\DEDITEC\DELIB\include\ delib.h"

"C:

- Start LabVIEW and open the menu "Tools -> Import -> DLL ..."
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- Choose the option "create VIs for DLL" and press continue
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- In the next window, choose the path to the delib.h and delib.dll
and press continue
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- Press continue again
- The Header-File will now be analized. Afterwards press continue.
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- Follow the instructions and configurate the name and the
saving location for the VIs.
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- In the new window choose "Easy error correction" in the dropdown menu and press continue.
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- VIs which are working with 64-bit values must be edited. The
display must be changed from "unsigned long" to "unsigned
quad".
- The following VIs must be edited:
-> DapiCNT48CounterGet48 (function return)
-> DapiDIGet64 (function return)
-> DapiDOSet64 (data)
-> DapiDOReadBack64 (function return)
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- In addition for some VIs you need to change the elementype to
"numeric".
- The following VIs must be edited:
-> DapiWriteLongLong (value)
-> DapiReadLongLong (function return)
- Afterwards press continue.
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- You recive a summary of the executed steps.
- Press continue

- The VIs will now be created and are ready to use.
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4.1.6.8.2. Usage of t he VI s in LabVI E W

Some functions of the DELIB-library are expecting a string as a
parameter value.
This example shows how to use such functions in LabVIEW.
We will use the A/D converter function which is used to set the
voltage range as an example.
The definition of this function is:
void DapiADSetMode(ULONG handle, ULONG ch, ULONG mode);

The voltage ranges for this function are already defined in the
DELIB-library.

Example code in C/C++:
DapiADSetMode(handle, 0, ADDA_MODE_UNIPOL_5V);

This code can also be written like this:
DapiADSetMode(handle, 0, 1);

Software | Seite

79

In the delib.h file can you read the hexadecimal values to
determine the modes. The hex values must be convertet to
decimal.
After the installation of the DELIB-library, the delib.h file is
located
in
the
following
directory:
C:
\Programs\Deditec\DELIB\Include\delib.h
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The function could look like this in LabVIEW:

The channel and mode are passed as unsigned long

Software | Seite

81

4.1.6.8.3. Set t he module I D in LabVI E W

The following example shows the response of an RO-ETH module
in LabVIEW.
The definition for this function is:
ULONG DapiOpenModule(ULONG moduleID, ULONG nr);
The module ID (for example "RO_ETH") of the module used is
usually transferred as a parameter for moduleID.
An overview of all possible module IDs can be found in the file
"delib.h".
You will find the delib.h after the installation of the DELIB driver
library in the directory: C:\Programme\Deditec\DELIB\Include
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Example in C:
handle = DapiOpenModule(RO_ETH, 0);
0.

// öffnet ein RO-ETH-Modul mit Modul-Nr

Alternatively, you can also use the following notation:
handle = DapiOpenModule(8, 0);

Software | Seite

83

Because LabVIEW does not allow you to pass these "C-Defines" as
parameters for the DapiOpenModule function, the alternate
notation must be used here.
Example in LabVIEW:
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4.1.6.9. Integration of the DELIB in Java

Depending on the DELIB installation, the required files for Java
are located in the following directory
C:\Program Files (x86)\DEDITEC\DELIB\include\DelibJava
(32 Bit Installation)
C:\Program
Files\DEDITEC\DELIB64\\include\DelibJava
(64 Bit Installation)
If Eclipse is used, the DelibJava folder can be simply added to the
project by drag & drop.
Afterwards, the modules used must still be imported.
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4.2. DELIB driver library

4.2.1. Overview

The following figure explains the structure of the DELIB driver
library

The DELIB driver library allows an uniform response of DEDITEC
hardware with particular consideration of the following
viewpoints:
Independent of operating system
Independent of programming language
Independent of the product
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4.2.1.1. Supported programming languages

Our products are responsive via the following programming
languages:
C
C++
C#
Delphi
VisualBasic
VB.NET
MS-Office (VBA)
Java (Platform-independent, only for Ethernet products)
Java JNI (only for Windows, all products are supported)
If provided by the programming language / development
environment, we support both 32-bit and 64-bit projects.
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4.2.1.2. Supported operating systems

The following operating systems are compatible with our DELIB
driver library:
32-Bit:
Windows 10
Windows 8
Windows 7
Windows Vista
Windows XP
Windows 2000
Windows Server 2012
Windows Server 2008
Linux

64-Bit:
Windows 10 x64
Windows 8 x64
Windows 7 x64
Windows XP x64
Windows Vista x64
Windows Server 2012 x64
Windows Server 2008 x64
Windows Server 2003 x64
Linux x64
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4.2.1.3. SDK-Kit for Programmer

Integrate the DELIB into your application. On request, you will
receive free of charge installation scripts, which allow you to
integrate the DELIB installation into your application.
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4.2.2. DELIB Setup

The DELIB Setup will guide you through the installation of our
DELIB driver library.
You will then be guided through the configuration process as well
as the functional test for our various products.
The current version of the DELIB setup can be found on our
homepage for download.
Link:
http://www.deditec.de/de/downloads/delib-treiberbibliothek.html
The DELIB Setup guides you step by step through the installation
of the DELIB driver library, including the configuration and
commissioning of the products.
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The DELIB Setup checks the operating system and whether
versions of the DELIB driver library are already installed.
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Then you can choose whether to install the 32-bit or 64-bit
version of the DELIB driver library.
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Installation progress of the driver library.
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In addition, you can choose to install the DELIB sample programs.
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Installation progress of the DELIB sample programs.
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The program restarts to complete the installation. In the next
step, the product is configured and tested with the DELIB
Configuration Utility.
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4.2.3. DELIB Configuration Utility

4.2.3.1. Introduction 2

The DELIB Configuration Utility allows the user to configure the
ethernet, CAN or serial communication with a product.
This configuration is required before you can use the products.
In case of USB this configuration is only required if you want to
use multiple products of the same type on one pc.
The DELIB Configuration Utility is included in the DELIB driver
library.
Default path:
32-Bit: C:\Program Files (x86)\DEDITEC\DELIB\programs\delibconfiguration-utility.exe
64-Bit: C:\Program Files\DEDITEC\DELIB64\programs\delibconfiguration-utility_x64.exe
You can also find the DELIB Configuration Utility in the
Startmenu "All programms" -> "DEDITEC -> "DELIB Configuration
Utility".
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4.2.3.2. Create new module configuration or edit a existing
configuration

For a new configuration choose the interface in the left box and
press continue.
If you want to edit a existing configuration choose the
configuration from the right box and press continue.
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4.2.3.2.1. Module configurat ion E t hernet

If you create a new ethernet configuration you can search your
network for DEDITEC products.
In addition you can also create a configuration manually.
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In the final step of the configuration, you can perform other
options for communication encryption or I / O naming.
If you decide to use a manual configuration, start at this point.
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In the case of encryption, you can choose between Deactivated,
User or Admin.
Deactivated
unencrypted communication
No access to system settings
User
encrypted communication
Read-access to system settings
Admin
encrypted communication
Read-write access to system settings
The desired password for the encryption must be entered in the
Password field.
By clicking the button "Transfer settings for the encryption to the
module" you are prompted to press a hardware button on the
product.
Only after pressing this key the encryption options are accepted
by the product. (-> authentication)
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Our Ethernet products, offer you the opportunity to assign names
to the digital and analog I / Os. These are used, for example, on
the web interface or in our app.

Note
An admin communication is required to store the channel names.
The maximum character length is 16.
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4.2.3.2.1.1. Aut omat ic search

Behavior of the DELIB Configuration Utility when using multiple
network adapters in a window system.
When searching for DEDITEC Ethernet modules via the PC's
primary network adapter (ETH0), the network settings of the
DEDITEC product are ignored.
This means that our Ethernet products are found even if they are
not on the same network due to the IP address and subnet mask.
If, on the other hand, the Ethernet module is connected to a
different or non-primary network adapter (for example, ETH1), the
network configuration of the Ethernet module must be valid for
the module to be found.
Attention:
If a laptop is used, the integrated WLAN adapter is usually
configured as the primary network adapter.
This means that modules that are connected to the laptop via a
LAN cable are often not recognized because the network
configuration is not valid.
For module installation, it is recommended to disable the WLAN
adapter at short notice.
The following graphic shows an overview of the automatic
search.
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After the automatic search, all DEDITEC Ethernet products are
displayed in an overview.
The overview shows the MAC address, the DHCP status, the IP,
the module name, the product types and the status of the write
protection.
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By clicking on a module the network configuration for this
module can be changed.
Please note that write protection must be switched off if you
want to save the settings
The write protection can be
authentication. (-> authentication)

temporarily

disabled

via

Note
Please note that in this step, only the module configuration is
changed.
If the module has already been configured in the DELIB
configuration utility, this configuration must be adapted to the
new module configuration.
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4.2.3.2.1.2. Set up an encry pt ion

In order to be able to process important module settings (for
example network configuration) via TCP, the communication
between the module and the PC must be in the so-called
encrypted admin mode.
For this purpose, a password for encryption must be configured
in the module and on the PC side.
This configuration can optionally be created by the automatic
wizard or manually.
Manual configuration
In the case of manual configuration, a password for encryption
must be defined on the module and PC side.
Step 1 - Configuration module-side
First, the module is configured via the web interface. Enter the IP
address of the module (delivery state 192.168.1.1) in an Internet
browser.
If an authentication is necessary, log in (delivery state: user =
admin + password = admin).
Now open the security settings (Configuration -> Security)
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If disabled, enable the Allow admin-encrypted protocol
setting, then use Set password to set a new password for
encryption.

With Update parameter, the configuration is completed if a new
password has been entered correctly.
Note
All characters are allowed when entering the password.
Typically, the password should be composed of a combination of
uppercase and lowercase letters, numbers, and special
characters.
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Step 2 - Configuration PC-side
Start the DELIB Configuration Utility and select the desired
Ethernet module.
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Here, select "Admin" for encryption.
Enter the password from step 1 in the newly appearing
password field.
With "Test", the new encrypted admin mode communication can
be tested.
The DELIB Configuration Utility can now be closed.
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Automatic configuration
Start the DELIB Configuration Utility and select the desired
Ethernet module.

1) Select Admin for encryption.
2) Enter a password in the newly appearing password field.
3) With encryption settings transferred to the module, the
current encryption settings are transferred to the module.
Note
All characters are allowed when entering the password.
Typically, the password should be composed of a combination of
uppercase and lowercase letters, numbers, and special
characters.
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To protect the module against unauthorized access,
authentication must be performed when editing system settings.
Depending on the product type, you will be prompted to press the
firmware reset button of the module for a certain time (RO-ETH
and RO-CPU-800) or change DIP switch settings (all other
products, eg RO-ETH / LC) , NET-ETH, ETH-RELAIS-8, etc...
The following example shows how authentication is performed
on an RO-ETH / LC module.
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In the first step, you are asked to invert the position of DIP switch
2.
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In the second step, DIP switch 2 is reset to the initial position.
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Authentication completed successfully. You are now temporarily
authorized to edit system settings.

After successful authentication, the encryption settings are
transferred to the module.
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4.2.3.3. Module test

After the configuration of the interface can you test the product
itself.
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Test of the firmware and show additional module-information.
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The module information shows addition properties of the product
and you can also see the number of I/Os and the supportet
software features.
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Now the I/Os will be testet. In this example the digital outputs
will be switched on.

If all tests are ok the module is ready to use.
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4.2.4. DELIB Module Demo

After installing the DELIB driver library, the program DELIB
Module Demo can be started in the following way:
Start
Programs
DEDITEC
DELIB or DELIB64
Sample Programs
DELIB Module Demo.
The DELIB Module Demo program is an all-in-one tool that
controls and tests all the I / Os of all S & R products.
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4.2.4.1. Select the module

When a program is started, a module must be selected.
1. Click the "Module Selector". You will get a list of the available
/ connected modules.
2. Select the desired module.
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4.2.4.2. General

1. Timeout status ( "Disabled", "Enabled" or "Occured").
2. Enables or disables the timeout protection.
3. Timeout time for timeout protection.
4. Status for "Automatic read / write" (flashing when "Automatic
read / write" is activated).
5. The "Automatic read / write" check box is used to determine
whether the measured data should be read / written
automatically.
6. Manual reading / writing. Only active if "Automatic read / write"
is deactivated.
7. The currently selected module can be configured here via the
DELIB Configuration Utility.
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8. If supported by the module, you will receive detailed debug
information.
9. This gives you detailed information about the selected module.
10. Communication status with the selected module.

4.2.4.2.1. Module info

This example shows the extended information of the module ROSER-O16-M16.
1. General information of the selected module.
2. Number of connected I / O channels.
3. Overview of supported interfaces DELIB commands.
4. Overview of supported I / O DELIB commands.

Software | Seite 125

4.2.4.3. Digital input

This example shows the digital inputs of an RO-SER-O16 module.
1. Select the channel range to be displayed.
2. The "Read with reset" checkbox is used to determine whether
the counters are reset when they are read again.
3. Counting stops of input counters.
4. States of the inputs.
5. Change of the input states (since last readout).
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4.2.4.4. Digital output

This example shows the digital outputs of an RO-SER-M32
module.
1. Select the channel range to be displayed.
2. All outputs of the current channel range are switched on or off.
3. Here, certain outputs can be selectively switched on or off.
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4.2.5. DELIB Module Config

The DELIB Module Config is a new application for configuring our
products. This program is included in the installation package of
our DELIB driver library.

4.2.5.1. Network settings

Here, you can change the network settings for the selected
Ethernet product.
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Board name
The board name can be used for device identification. If DHCP is
active, the board name is used as hostname.
Protect network configuration
If the network configuration is protected, it can only be changed
via the web interface.
This prevents unauthorized access to the network configuration
(for example, using the DELIB Configuration Utility)
The protection can be temporarily deactivated (3min) by pressing
a short (2 sec) of the 'FW reset key' on the device
MAC-address
The MAC address is the physical address of the product and is
fixed to the hardware.
Obtain the IP address automatically via DHCP
If this option is enabled, the device tries to obtain a valid IP
address from a DHCP server on the network´.
The board name is used as hostname.
IP address, netmask, default gateway and TCP port
These settings are used when DHCP is disabled. If in doubt,
please ask your responsible system administrator.
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4.2.5.2. User administration

Here you can make the user settings for the web interface.

Session Time (10 - 65535 seconds)
Timeout for inactivity. When session time 0 is reached, the user
is logged out automatically from the web interface.
Login required
If this option is active, a username / password is required to
access the web interface.
Account name
Used when the Login required field is enabled. Maximum of 16
characters.

Software | Seite 130

Account password
Used when the Login Required field is enabled. Maximum of 16
characters.
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4.2.5.3. Serial configuration

Through this page you can configure the entire configuration of
our products with a serial interface.

"Special mode"
In the "special mode", the module is automatically operated with
the following settings:
Baudrate: 115200
Module-nr. 0
Echo = off
Register-mode = On
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Baudrate
If the "special mode" is deactivated, the speed of the
communication can be set.
625000
250000
125000
115200
57600
50000
38400
19200
9600
4800
2400
1200
600
300
RS485 module address
Address for identification the RS485 bus.
Echo
Serial-received characters are returned by the module.
Register mode
Deactivate the register mode to activate the text mode.
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4.2.6. DT-Flasher

After installing the DELIB driver library, the program DT-Flasher
can be started in the following way:
Start
Programs
Flasher.

DEDITEC

DELIB or DELIB64

DT-
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4.2.6.1. About DEDITEC firmware

Most DEDITEC products have their own microcontroller. This
processor is responsible for the control of all processes of the
hardware.
In order to change the firmware required for the processor in the
future, we provide our free tool DT-Flasher. With this tool, the
customer has the possibility to transfer newly released firmware
versions directly to the module on site.
Note:
As new firmware versions usually "unblock" new features for your
product, we recommend a regular fimware update of your
DEDITEC products.
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4.2.6.2. Select the module

1. When you start the program, select the module you want to
update with a new firmware. For this purpose, you will find a list
of all available modules in the "Module Selector".
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4.2.6.3. Firmware update

This example shows the module RO-SER-CNT8-AD32-DA8-PT1004-STEPPER2 before a firmware update.
1. Logbook - All messages during the firmware update are
displayed here. Auto-scroll determines whether to scroll down
to the last event automatically. Clear log clears the entire
logbook.
2. Here you can get information about the interface module (in
this example, the RO-SER interface). Newest FW displays the
latest firmware version available for the module. Current FW
displays the version currently available on the module. After the
module is successfully flashed, Last FW shows the version that
was played before the firmware update. If the checkmark is set to
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detailed debuginfo, detailed messages are written to the
logbook (1) during the firmware update. The firmware update for
the interface module is started with Flash module.
3. You can download the latest firmware versions, so-called flash
files, directly from the application.
4. FW-Ver shows the current firmware version of the submodule.
New-FW-Ver displays the latest version available for this
submodule. The firmware update for the respective submodule is
performed via the Flash button.
5. The button Flash all submodules performs the firmware
update for all connected submodules.
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4.2.6.3.1. Updat e F lash files manually

In some cases, it is necessary to manually update the flash files,
e.g. If no administrator rights are available on the PC.
Step 1:
Download the latest version of the Flash-Files
http://www.deditec.de/zip/deditec-flash_files.zip
Step 2:
Unzip the downloaded ZIP archive, depending on the DELIB
installation, to the following directory.
x86
C:\Program Files(x86)\DEDITEC\DELIB\programs\
x64
C:\Program Files\DEDITEC\DELIB\programs
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4.3. DELIB Sample Sources (Example programs)
The DELIB Sample Sources provide sample programms
including source code for almost every DEDITEC product.
For a quick start you can find the source codes for the following
programming languages:
C
C++
C#
Delphi
VisualBasic
VB.NET
MS-Office
LabVIEW
Java
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4.3.1. Installation DELIB Sample Sources

The DELIB Sample Sources can be installed either during the
DELIB setup or as a stand-alone setup.
Insert the DEDITEC Driver CD into the drive and start
delib_sample_sources_install.exe.
A current version of the Sample Sources can also be found on
the Internet under
http://www.deditec.de/de/delib
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Startup screen of the DELIB Sample Sources Installer
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Press Next.

Select the installation folder and press Install
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The DELIB sample sources are now installed.

The DELIB Sample Sources have been successfully installed.
Press Close to finish the installation.
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4.3.2. Using the DELIB Sample Sources

After the installation the DELIB Sample Sources can be found
here:
Start -> Programme -> DEDITEC -> DELIB -> Sample-Sources
-> Sources

Now the Windows Explorer opens with an overview of all
products for which a sample program is available.
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4.3.2.1. Step 1 - Product selection

For example you need help with the programming of the digital
inputs of a RO-ETH-Module (e.g. RO-ETH-O16) with the
programming language Visual-C.
Because it is a RO-ETH product, select or open the ro-eth-serie
folder
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4.3.2.2. Step 2 - Category selection

In the next step, you will find an overview of the available
categories for the selected product.
As we focus on the digital inputs in this example, select the
category digital-input
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4.3.2.3. Step 3 - Programing language selection

In this step, you will see all available programming examples of
the selected categories, sorted by programming languages.
As we focus on the Visual-C programming language in this
example, open the vc folder.
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4.3.2.4. Step 4 - Source code

In the forth and last step you will find the sample project files
including the source code.
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The source code of the example program (in this case the .cppfile) can be opened with a texteditor.
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In addition you can find in the debug folder a compiled .exe file
which can be executed.
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4.4. DELIB for Linux
Download the Delib Linux driver library from "www.deditec.de/de/
downloads/produkte/" in the "DELIB+Protocols" tab
or
under
"www.deditec.de/media/zip/delib/delib-linux.zip"
directly to your Linux system.
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Unzip the "delib-linux.zip" to any destination folder. To do this,
double-click the zip file and then use the "Unzip" button in the top
menu bar.

Select your destination folder and then click the "Unzip" button.
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4.4.1. Using the DELIB driver library for Linux

4.4.1.1. Delib ETH-Sample in Linux

Default settings
In this program example the module is addressed with the IP
"192.168.1.21". You can change this in the file
"/samples/ethernet_sample/source/eth_sample.c"
picture below).

(see

If you have preset a password for an encrypted TCP connection,
you can also enter it there (see picture below). If you did not
specify a password, you can leave this line unchanged.
The configuration of the ETH modules can be set via the DELIB
Configuration Utility as well as via the web interface of the
module.
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If you use a module without digital inputs, you must comment
out the lines in the same file as shown below.
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Compiling the ETH sample
For compiling the test program, open a terminal window and
navigate with the command
"cd /<directory path>" to the "/samples/ethernet_sample"
directory.
Tip: If there are spaces in your folder name, enter it as shown in
the example below
in " " as shown in the example below.

To compile, now open the desired shell script with the command
"sudo sh ./<DATEINAME>"
If you want to access the module via an unencrypted TCP
connection, use the file "1_compile_ethernet_sample.sh".
If you want to access the module via an encrypted TCP
connection,
use
the
file
"2_compile_ethernet_sample_with_encryption.sh".
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Enter your user password if necessary.

If the compilation was successful, "compiling successful"
should now appear in the terminal window.
The file "ethernet_sample" has been added to the directory.
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Now you can execute the sample program with "sudo ./
ethernet_sample".
IMPORTANT!! You need admin rights to run it. Therefore use the
command with "sudo".

The program is now executed.
In this example, all outputs of the module are switched on and off
again in a loop.
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4.4.2. DELIB CLI (command-line interface) für Linux

The DELIB CLI command for Linux is located in the folder /
deditec-cli/ after unpacking the zip archive "delib-linux-cli".
Definition for USB-Modules (Linux)
sudo delib_cli [command] [channel] [value | unit ["nounit"] ]

Definition for ETH-Modules (Linux)
delib_cli [command] [channel] [value | unit ["nounit"] ]
Note: The individual parameters are only separated by a space.
Upper and lower case are not considered here.
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Parameter
command channel
di1

value

nounit

0, 1, 2, ...

di8
di16

unit

0, 8, 16, ...

-

hex

nounit

hex

nounit

-

-

di32
ff

0, 32, ...

-

do1

0, 1, 2, ...

0/1 (1-Bit Command)
8Bit
Val
ue

do8

do16

16(Bit 0 for channel
Bit
0, 8, 16, ...
1, Bit 1 for
Val
channel 2, ...)
ue
32Bit
Val
ue

do32

ai

ao

0, 1, 2, ...

-

0, 1, 2, ...

Integer or
hexadecimal number

hex, volt,
nounit
mA
-

-

(starting with 0x).
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Return value
State of the read digital inputs
In combination with parameter unit "hex" the state is read as hex
State of the FlipFlips of the digital inputs
In combination with parameter unit "hex" the state is read as hex
State of the read analog inputs
In combination with the parameter unit "hex" the state is read as
hex.
In combination with parameter unit "volt" the voltage is read
In combination with parameter unit "mA" the current is read
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4.4.2.1. Configuration of the Delib CLI

Default settings
Before using the DELIB CLI for the first time, the "delib_cli.cfg"
must be edited with a text editor.
You can find the "delib_cli.cfg" in the directory "/delib_cli/".
Contents of the "delib_cli.cfg" file:
moduleID=14;
moduleNR=0;
RO-ETH_ipAddress=192.168.1.11;

The corresponding number of the hardware used must be
entered as moduleID.
This number can be taken from the "delib.h".
Under Linux you find this in the zip archive of the "delib-linux"
under the path "delib-sources\delib\library\delib".
moduleNR
The moduleNR is assigned in the DELIB Configuration Utility.
This number is used to identify identical hardware.
The default value is 0.
RO-ETH_ipAddress
This entry is only needed for the connection to our ETH modules.
The IP address of the ETH modules can be set via the DELIB
Configuration Utility as well as via the web interface of the
module.
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Compiling the Delib CLI Sample
To compile the test program, open a terminal window and
navigate with the command
"cd /<directory path>" first into the "../delib_cli/" directory.
Hint: If there are spaces in your folder name, enter it as shown in
the example below
in " " as shown in the example below.

To compile, now open the desired shell script with the command
"sudo sh ./<FILENAME>"
ETH - "1_compile_delib-cli_eth.sh"
USB - "2_compile_delib-cli_usb.sh"
Enter your user password if necessary.
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If the compilation was successful, "compiling successfull"
should now appear in the terminal window. The file "delib_cli"
has been created in the directory. Now you can compile the
sample program with
"sudo ./delib_cli
["nounit"] ] "

[command]

[channel]

[value

|

unit

IMPORTANT!! You need admin rights to run it. Therefore use the
command with "sudo".
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4.4.2.2. DELIB CLI Examples
Digital outputs
sudo delib_cli DO1 17 1
-> switches on the 18th digital relay of a USB module
sudo delib_cli DO1 3 0
-> switches off the 4th digital relay of a RO-ETH module

Digital inputs
sudo delib_cli DI1 3
Example of a return value: 1
-> read the state of the 4th digital input of a USB module and return it
sudo delib_cli DI8 0 hex
Example of a return value: 0xFF
(a signal is present on channels 1 to 8)
-> read the value of digital input 1-8 of a RO-ETH module as hexadecimal number
sudo delib_cli FF 0
Example of a return value: 192
(a change of state was detected on channels 7 and 8)
-> read the value of the FlipFlops of the digital inputs 1-32
sudo delib_cli FF 32
Example of a return value: 65535
(a change of state was detected on channels 33 to 64)
-> read the value of the FlipFlops of the digital inputs 33-64
sudo delib_cli FF 0 hex
Example of a return value: 0xD 00
(a change of state was detected on channels 9, 11 and 12)
-> read the value of the FlipFlops of the digital inputs 1-32 as hexadecimal number
sudo delib_cli FF 32 hex
Example of a return value: 0x3
(a change of state was detected on channels 33 and 34)
-> read the value of the FlipFlops of the digital inputs 0-64 as hexadecimal number
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Analog outputs
sudo delib_cli AO 7 4711
-> sets the decimal value 4711 to the 8th analog output of a USB module
sudo delib_cli AO 6 0x4711
-> sets the hexadecimal value 0x4AF1 to the 7th analog output of a RO-ETH module

Analog inputs
sudo delib_cli AI 2
Example of a return value: 1234
-> reads the value of the 3rd analog input as decimal number of a USB module
sudo delib_cli AI 2 hex
Example of a return value: 0x1FA
-> reads the value of the 3rd analog input as hexadecimal number of a RO-ETH module.

Software | Seite 166

DELIB API Reference

V

DELIB API Reference | Seite 167

5. DELIB API Reference
5.1. Management functions

5.1.1. DapiOpenModule

Description
This function opens a specific module.
definition
ULONG DapiOpenModule(ULONG moduleID, ULONG nr);

Parameter
moduleID=Gives the module to open (see delib.h)
nr=Specifies which module to open (for multiple modules).
nr=0 -> 1st module
nr=1 -> 2nd module
Return-Value
handle=Appropriate handle for the module
handle=0 -> Module was not found
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remark
The handle returned by this function is used to identify the
module for all other functions.
programming example
// USB-Modul öffnen
handle = DapiOpenModule(RO_USB1, 0);
printf("handle = %x\n", handle);
if (handle==0)
{
// USB Modul wurde nicht gefunden
printf("Modul konnte nicht geöffnet werden\n");
return;
}
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5.1.2. DapiCloseModule

Description
This command closes an open module.
Definition
ULONG DapiCloseModule(ULONG handle);

parameter
handle=This is the handle of an open module.
return value
None
programming example
// Modul close
DapiCloseModule(handle);
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5.1.3. DapiGetDELIBVersion

Description
This function returns the installed DELIB version.
Definition
ULONG DapiGetDELIBVersion(ULONG mode, ULONG par);

Parameters
mode=Mode, with which the version is readout (must be 0).
par=This parameter is not defined (must be 0).
Return value
version=Version number of the installed DELIB version [hex].
Example program
version = DapiGetDELIBVersion(0, 0);
//With installed Version 1.32 ist version = 132(hex)
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5.1.4. DapiSpecialCMDGetModuleConfig

Description
This function returns the hardware equipment (number of input
and output channels) of the module.
definition
ULONG
DapiSpecialCommand(ULONG
DAPI_SPECIAL_CMD_GET_MODULE_CONFIG, par, 0, 0);

handle,

parameter
handle=This is the handle of an open module
Querying the number of digital input channels
par=DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_DI
Query number of digital input flip-flops
par=DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_DI_FF
Query number of digital input counters (16-bit counter)
par=DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_DI_COUNTER
Query number of digital input counters (48-bit counter)
par=DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_CNT48
Querying the number of digital output channels
par=DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_DO
Querying the number of digital pulse generator outputs
par=DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_PULSE_GEN
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Querying the number of digital PWM outputs
par=DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_PWM_OUT
Querying the number of digital input/output channels
par=DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_DX
Querying the number of analog input channels
par=DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_AD
Querying the number of analog output channels
par=DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_DA
Query number of temperature channels
par=DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_TEMP
Query number of stepper channels
par=DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_STEPPER
return value
Querying the number of digital input channels
return=number of digital input channels
Query number of digital input flip-flops
return=number of digital input flip-flops
Query number of digital input counters (16-bit counter)
return=number of digital input counters (16-bit counter)
Query number of digital input counters (48-bit counter)
return=number of digital input counters (48-bit counter)
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Querying the number of digital output channels
return=number of digital output channels
Querying the number of digital pulse generator outputs
return=number of digital pulse generator outputs
Querying the number of digital PWM outputs
return=number of digital PWM outputs
Querying the number of digital input/output channels
return=number of digital input/output channels
Querying the number of analog input channels
return=number of analog input channels
Querying the number of analog output channels
return=number of analog output channels
Query number of temperature channels
return=number of temperature channels
Query number of stepper channels
return=number of stepper channels
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programming example
ret=DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_GET_MODULE_CONFIG,
DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_DI, 0, 0);
//Returns the number of digital input channels
ret=DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_GET_MODULE_CONFIG,
DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_DO, 0, 0);
//Returns the number of digital output channels
ret=DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_GET_MODULE_CONFIG,
DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_DX, 0, 0);
//Returns the number of digital input/output channels
ret=DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_GET_MODULE_CONFIG,
DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_AD, 0, 0);
//Returns the number of analog input channels
ret=DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_GET_MODULE_CONFIG,
DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_DA, 0, 0);
//Returns the number of analog output channels
ret=DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_GET_MODULE_CONFIG,
DAPI_SPECIAL_GET_MODULE_CONFIG_PAR_STEPPER, 0, 0);
//Returns the number of stepper channels
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5.1.5. DapiOpenModuleEx

Description
This function opens a specific module with ethernet interface.
The particularity of this command is, that parameters like IPaddress, portnumber and timeout can be specified.
Definition
ULONG DapiOpenModuleEx(ULONG moduleID, ULONG nr, unsigned char* exbuffer,
0);

Parameters
moduleID = Specifies the module, which is to be opened (see
delib.h)
nr = Indicates No of module which is to be opened.
nr = 0 -> 1. module
nr = 1 -> 2. module
exbuffer = buffer for IP-adresse, port and timeout
Return value
handle = handle to the corresponding module
handle = 0 -> Module was not found
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Remarks
The handle returned by this function is needed to identify the
module for all other functions.
This command is only support by modules with ethernet
interface.
Universal Ethernet moduleID
The moduleID:
ETHERNET_MODULE = 29
is a universal Ethernet moduleID and can be used to address any
Ethernet product.
Encryption Type
The following encryption types are available:
DAPI_OPEN_MODULE_ENCRYPTION_TYPE_NONE = 0
DAPI_OPEN_MODULE_ENCRYPTION_TYPE_NORMAL = 1
DAPI_OPEN_MODULE_ENCRYPTION_TYPE_ADMIN = 2

DELIB API Reference | Seite 177

Example program
// Open ETH-Module with parameter
DAPI_OPENMODULEEX_STRUCT open_buffer;
strcpy((char*) open_buffer.address, "192.168.1.10");
open_buffer.portno = 0;
open_buffer.timeout = 5000;
handle = DapiOpenModuleEx(RO_ETH, 0, (unsigned char*) &open_buffer, 0);
printf("Module handle = %x\n", handle);
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5.2. Error handling

5.2.1. DapiGetLastError

Description
This function returns the last recorded error.
Definition
ULONG DapiGetLastError();

parameter
None
return value
Error Code
0=no error. (see delib.h)
programming example
ULONG error;
error=DapiGetLastError();
if(error==0) return FALSE;
printf("ERROR = %d”, error);
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5.2.2. DapiGetLastErrorByHandle

Description
This function returns the last registered error of a particular
module (handle). If an error has occurred, it must be deleted with
DapiClearLastErrorByHandle(),
otherwise
any
call
of
DapiGetLastErrorByHandle() will return the "old" error.
Definition
ULONG DapiGetLastErrorByHandle(ULONG handle);

Parameters
handle=This is the handle of an opened module.
Return value
Error code
0=no error. (see delib_error_codes.h)
Example program
BOOL IsError(ULONG handle)
{
unsigned long error_code = DapiGetLastErrorByHandle(handle);
if (error_code != DAPI_ERR_NONE)
{
printf("Error detected on handle 0x%x - Error Code = 0x%x\n", handle,
error_code);
DapiClearLastErrorByHandle(handle);
return TRUE;
}
return FALSE;
}
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5.2.3. DapiClearLastErrorByHandle

Description
This function deletes the last error of a particular module
(handle), which was registered with DapiGetLastErrorByHandle().
Definition
void DapiClearLastErrorByHandle(ULONG handle);

Parameters
handle=This is the handle of an opened module.
Return value
None
Example program
BOOL IsError(ULONG handle)
{
unsigned long error_code = DapiGetLastErrorByHandle(handle);
if (error_code != DAPI_ERR_NONE)
{
printf("Error detected on handle 0x%x - Error Code = 0x%x\n", handle,
error_code);
DapiClearLastErrorByHandle(handle);
return TRUE;
}
return FALSE;
}
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5.2.4. DapiClearLastError

Description
This function deletes
DapiGetLastError().

the

last

error

registered

with

Definition
void DapiClearLastError();

Parameters
None
Return value
None
Example program
BOOL IsError()
{
unsigned char msg[500];
unsigned long error_code = DapiGetLastError();
if (error_code != DAPI_ERR_NONE)
{
DapiGetLastErrorText((unsigned char*) msg, sizeof(msg));
printf("Error Code = 0x%x * Message = %s\n", error_code, msg);
DapiClearLastError();
return TRUE;
}
return FALSE;
}
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5.2.5. DapiGetLastErrorText

Description
This function reads the text of the last recorded error.
Definition
extern ULONG __stdcall DapiGetLastErrorText(unsigned char * msg, unsigned long
msg_length);

parameter
msg = buffer for the text to be received
msg_length = length of the text buffer
programming example
BOOL IsError ()
{
if (DapiGetLastError () != DAPI_ERR_NONE)
{
unsigned char msg[500];
DapiGetLastErrorText((unsigned char*) msg, sizeof(msg));
printf ("Error Code = %x * Message = %s\n", 0, msg);
return TRUE;
}
return FALSE;
}

DELIB API Reference | Seite 183

5.3. Reading Digital inputs

5.3.1. DapiDIGet1

Description
This command reads a single digital input.
Definition
ULONG DapiDIGet1(ULONG handle, ULONG ch);

parameter
handle=This is the handle of an open module.
ch=States the number of the input to be read (0, 1, 2, 3, .. )
Return-Wert
Status of the input (0/1)
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5.3.2. DapiDIGet8

Description
This command reads 8 digital inputs simultaneously.
Definition
ULONG DapiDIGet8(ULONG handle, ULONG ch);

parameter
handle=This is the handle of an open module.
ch=States the number of the input from which the read is to start
(0, 8, 16, 24, .. )
return value
Status of the read inputs
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5.3.3. DapiDIGet16

Description
This command reads 16 digital inputs simultaneously.
Definition
ULONG DapiDIGet16(ULONG handle, ULONG ch);

parameter
handle=This is the handle of an open module.
ch=Gives the number of the input from which reading is to start
(0, 16, 32, ...)
return value
Status of the read inputs
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5.3.4. DapiDIGet32

Description
This command reads 32 digital inputs simultaneously.
Definition
ULONG DapiDIGet32(ULONG handle, ULONG ch);

parameter
handle=This is the handle of an open module.
ch=Gives the number of the input from which the read is to start
(0, 32, 64, ..)
Return-Value
Status of the read inputs
programming example
unsigned long data;
// ---------------------------------------------------// Read a value from the inputs (input 1-31)
data = (unsigned long) DapiDIGet32(handle, 0);
// Chan start = 0
printf("Input 0-31 : 0x%x\n", data);
printf("Key for continue");
getch();
// ---------------------------------------------------// Read a value from the inputs (input 32-64)
data = (unsigned long) DapiDIGet32(handle, 32);
// Chan start = 32
printf("Input 32-64 : 0x%x\n", data);
printf("Key for continue");
getch();
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5.3.5. DapiDIGet64

Description
This command reads 64 digital inputs simultaneously.
Definition
ULONGLONG DapiDIGet64(ULONG handle, ULONG ch);

parameter
handle=This is the handle of an open module.
ch=Gives the number of the input from which the read is to start
(0, 64, ..)
return value
Status of the read inputs
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5.3.6. DapiDIGetFF32

Description
This command reads the flip-flops of the inputs and resets them
(input state change).
Definition
ULONG DapiDIGetFF32(ULONG handle, ULONG ch);

Parameter
handle=This is the handle of an open module.
ch=Gives the number of the input from which the read is to start
(0, 32, 64, ..)
return value
State of 32 input state changes
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5.3.7. DapiDIGetCounter

Description
This command reads the input counter of a digital input.
Definition
ULONG DapiDIGetCounter(ULONG handle, ULONG ch, ULONG mode);

Parameter
handle=This is the handle of an open module.
ch=Gives the number of the input from which the read is to start.
mode=0 (Normal counting function)
mode=DAPI_CNT_MODE_READ_WITH_RESET (read counter and
reset direct counter)
mode=DAPI_CNT_MODE_READ_LATCHED (Reading the stored
meter reading)
Return-Value
Indication of the counter value
programming example
value = DapiDIGetCounter(handle, 0 , 0);
// Counter of DI Chan 0 is read
value = DapiDIGetCounter(handle, 1 , 0);
// Counter of DI Chan 1 is read
value = DapiDIGetCounter(handle, 8 ,0);
// Counter of DI Chan 8 is read
value = DapiDIGetCounter(handle, 0 , DAPI_CNT_MODE_READ_WITH_RESET);
// counter of DI Chan 0 is read AND reset
value = DapiDIGetCounter(handle, 1 , DAPI_CNT_MODE_READ_LATCHED);
// Read the stored counter value of DI Chan 1
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5.3.8. DapiSpecialCounterLatchAll

Description
This command saves the counters of all digital inputs
simultaneously into a temporary storage (latch).
So, after that, the counter of the latch can be read successively.
Here, the speciality is, that it is possible to "freeze"
simultaneously the counter and the frozen counter (latch) can be
read one by one.
Definition
void DapiSpecialCommand(ULONG handle, DAPI_SPECIAL_CMD_COUNTER,
DAPI_SPECIAL_COUNTER_LATCH_ALL, 0, 0);

Parameters
None
Return-value
None
Remarks
Modules supported by these commands can be found in our
DELIB Overview Table.
Example program
DapiSpecialCommand(ULONG handle, DAPI_SPECIAL_CMD_COUNTER,
DAPI_SPECIAL_COUNTER_LATCH_ALL, 0, 0);
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5.3.9. DapiSpecialCounterLatchAllWithReset

Description
This command saves the counters of all digital inputs
simultaneously into a temporary storage (latch).
In addition, the counters of the digital inputs will be reset.
Definition
void DapiSpecialCommand(ULONG handle, DAPI_SPECIAL_CMD_COUNTER,
DAPI_SPECIAL_COUNTER_LATCH_ALL_WITH_RESET, 0, 0);

Parameters
None
Return-value
None
Remarks
Modules supported by these commands can be found in our
DELIB Overview Table.
Example program
DapiSpecialCommand(ULONG handle, DAPI_SPECIAL_CMD_COUNTER,
DAPI_SPECIAL_COUNTER_LATCH_ALL_WITH_RESET, 0, 0);
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5.3.10. DapiSpecialDIFilterValueSet

Description
This command sets an input filter in [ms], in which time interval
noise pulses are filtered at digital input channels.
Definition
DapiSpecialCommand(handle,
DAPI_SPECIAL_CMD_DI,
DAPI_SPECIAL_DI_FILTER_VALUE_SET, ULONG time_ms, 0);

Parameters
handle=This is the handle of an opened module.
time_ms=Time interval [ms] by which digital input channels are
sampled.
Remarks
Default value:

0ms

Value range:

0(=off) , 1(ms) - 254(ms)

Modules supported by these commands can be found in our
DELIB Overview Table.
Example program
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_DI,
DAPI_SPECIAL_DI_FILTER_VALUE_SET, 5, 0);
// Sets the time interval to 5ms
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_DI,
DAPI_SPECIAL_DI_FILTER_VALUE_SET, 150, 0);
// Sets the time interval to 150ms
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5.3.11. DapiSpecialDIFilterValueGet

Description
This command returns the previously set value of the time
interval for filtering noise pulses at digital input channels in [ms].
Definition
ULONG
DapiSpecialCommand(handle,
DAPI_SPECIAL_DI_FILTER_VALUE_GET, 0, 0);

DAPI_SPECIAL_CMD_DI,

Parameters
handle=This is the handle of an opened module.
Return value
Time [ms]
Remarks
Modules supported by these commands can be found in our
DELIB Overview Table.
Example program
value = DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_DI,
DAPI_SPECIAL_DI_FILTER_VALUE_GET, 0, 0);
//Returns the time interval for sampling the digital input channels
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5.3.12. Dapi_Special_DI_FF_Filter_Value_Set

Description
This command sets a filter [ms], in which time interval the input
flip-flops and the input counters are polled.
Definition
void
DapiSpecialCommand(handle,
DAPI_SPECIAL_CMD_DI,
DAPI_SPECIAL_DI_FF_FILTER_VALUE_SET, ULONG time_ms, 0);

Parameters
handle=This is the handle of an opened module.
time_ms=time interval [ms], in which digital inputs are sampled.
Remarks
This command only supports pulse durations between 5ms and
255ms.
If no time is set, the default value (100ms) will be used.
Modules supported by these commands can be found in our
DELIB Overview Table.
Example program
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_DI,
DAPI_SPECIAL_DI_FF_FILTER_VALUE_SET, 5, 0);
// Sets the time interval to 5ms
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_DI,
DAPI_SPECIAL_DI_FF_FILTER_VALUE_SET, 150, 0);
// Sets the time interval to 150ms

DELIB API Reference | Seite 195

5.3.13. Dapi_Special_DI_FF_Filter_Value_Get

Description
This command returns the predefined value of the time interval
for sampling the input flip-flops and the input counters in [ms].
Definition
ULONG
DapiSpecialCommand(handle,
DAPI_SPECIAL_DI_FF_FILTER_VALUE_GET, 0, 0);

DAPI_SPECIAL_CMD_DI,

Parameters
handle=This is the handle of an opened module.
Return value
Time [ms]
Remarks
Modules supported by these commands can be found in our
DELIB Overview Table.
Example program
value = DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_DI,
DAPI_SPECIAL_DI_FF_FILTER_VALUE_GET, 0, 0);
//Returns the time interval for sampling the digital input channels.
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5.4. Setting Digital outputs

5.4.1. DapiDOSet1

Description
This command sets a single output.
Definition
void DapiDOSet1(ULONG handle, ULONG ch, ULONG data);

Parameter
handle=This is the handle of an open module.
ch=Gives the number of the output to be set (0 .. )
data=Gives the data value to be written (0 / 1)
Return value
None
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5.4.2. DapiDOSet8

Description
This command sets 8 digital outputs simultaneously.
Definition
void DapiDOSet8(ULONG handle, ULONG ch, ULONG data);

Parameters
handle=This is the handle of an open module.
ch=Gives the number of the output from which writing is to start
(0, 8, 16, 24, 32, ..)
data=Specifies the data values to be written.
Return value
None
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5.4.3. DapiDOSet16

Description
This command sets 16 digital outputs simultaneously.
Definition
void DapiDOSet16(ULONG handle, ULONG ch, ULONG data);

Parameter
handle=This is the handle of an open module.
ch=Gives the number of the output from which writing is to start
(0, 16, 32, ..)
data=Gives the data values that are to be written.
Return value
None

DELIB API Reference | Seite 199

5.4.4. DapiDOSet32

Description
This command simultaneously sets 32 digital outputs.
Definition
void DapiDOSet32(ULONG handle, ULONG ch, ULONG data);

Parameters
handle=This is the handle of an open module.
ch=Gives the number of the output from which writing is to start
(0, 32, 64, ..)
data=Gives the data values that are to be written.
Return value
None
programming example
// Write a value to the outputs
data = 0x0000ff00; // Set outputs 9-16 to 1
DapiDOSet32(handle, 0, data); // Chan start = 0
printf("Write to outputs data=0x%x\n", data);
printf("key for continue");
getch();
// ---------------------------------------------------// Write a value to the outputs
data = 0x80000000; // Set output 32 to 1
DapiDOSet32(handle, 0, data); // Chan start = 0
printf("Write to outputs data=0x%x\n", data);
printf("key for continue");
getch();
// ---------------------------------------------------// Write a value to the outputs
data = 0x80000000; // Set output 64 to 1
DapiDOSet32(handle, 32, data); // Chan start = 32
printf("Write to outputs data=0x%x\n", data);
printf("key for continue");
getch();
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5.4.5. DapiDOSet64

Description
This command simultaneously sets 64 digital outputs.
Definition
void DapiDOSet64(ULONG handle, ULONG ch, ULONG data);

Parameters
handle=This is the handle of an open module.
ch=Gives the number of the output from which writing is to start
(0, 64, ..)
data=Gives the data values that are to be written.
Return value
None
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5.4.6. DapiDOSet1_WithTimer

Description
This function sets a digital output (ch) to a value (data - 0 or 1)
for a specified time in msec.
Definition
void DapiDOSet1_WithTimer(ULONG handle, ULONG ch, ULONG data, ULONG
time_ms);

Parameters
handle=This is the handle of an opened module
ch=Specifies the number of the output, from which it begins to
write to (0, 32, 64, ..)
data=Specifies the data values, to write to the outputs
time_ms=Specifies the time, in which an output is set [ms]
Return value
None
Remarks
This function will lose its validity, if it is overwritten with other
values.
If you want to deactivate this function, you will have to overwrite
it with time_ms=0.
Modules supported by these commands can be found in our
DELIB Overview Table.
Example program
DapiDOSet1_WithTimer(handle, 2, 1, 1000);
//Setting channel 2 for 1000msec to 1
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5.4.7. DapiDOReadback32

Description
This command reads back the 32 digital outputs.
Definition
ULONG DapiDOReadback32(ULONG handle, ULONG ch);

Parameter
handle=This is the handle of an open module.
ch=Gives the number of the output from which the readback is to
start (0, 32, 64, ..)
Return value
State of 32 outputs.
5.4.8. DapiDOReadback64

Description
This command reads back the 64 digital outputs.
Definition
ULONGLONG DapiDOReadback64(ULONG handle, ULONG ch);

Parameters
handle=This is the handle of an open module.
ch=Gives the number of the output from which the readback is to
start (0, 64, ..)
Return value
State of 64 outputs.
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5.4.9. DapiDOClrBit32

Description
This command can be used to switch outputs specifically to 0
without changing the states of the neighboring outputs.
Definition
void DapiDOClrBit32(uint handle, uint ch, uint data);

Parameter
handle = This is the handle of an open module
ch = Specifies the number of the output from which to write
data = Specifies the data value that is to be written (up to 32 bits)
Return value
none
Remark:
Only the bits with a significance of 1 in the data parameter are
taken into account by the command.
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Programming example
data = 0x1; // Output 0 is set to 0, the state of output 1-31 remains
unaffected
DapiDOSetBit32(handle, 0, data);
data = 0xf; // Output 0-3 is set to 0, the state of output 4-31 remains
unaffected
DapiDOSetBit32(handle, 0, data);
data = 0xff; // Output 0-7 is set to 0, the state of output 8-31 remains
unaffected
DapiDOSetBit32(handle, 0, data);
data = 0xff000000; // Output 23-31 is set to 0, the state of output 0-22
remains unaffected
DapiDOSetBit32(handle, 0, data);
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5.4.10. DapiDOSetBit32

Description
This command can be used to switch outputs specifically to 1
without changing the states of the neighboring outputs.
Definition
void DapiDOSetBit32(uint handle, uint ch, uint data);

Parameter
handle = This is the handle of an open module
ch = Specifies the number of the output from which to write
data = Specifies the data value that is to be written (up to 32 bits)
Return value
none
Remark:
Only the bits with a significance of 1 in the data parameter are
taken into account by the command.

DELIB API Reference | Seite 206

Programming example
data = 0x1; // Output 0 is set to 1, the state of output 1-31 remains
unaffected
DapiDOSetBit32(handle, 0, data);
data = 0xf; // Output 0-3 is set to 1, the state of output 4-31 remains
unaffected
DapiDOSetBit32(handle, 0, data);
data = 0xff; // Output 0-7 is set to 1, the state of output 8-31 remains
unaffected
DapiDOSetBit32(handle, 0, data);
data = 0xff000000; // Output 23-31 is set to 1, the state of output 0-22
remains unaffected
DapiDOSetBit32(handle, 0, data);
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5.5. Output timeout management

5.5.1. DapiSpecialCMDTimeout

Description
This command is used to set the timeout protection function.
There are three different timeout methods since 2021.
"normal" Timeout
This is the timeout that our modules have had since 2009.
Procedure for the timeout command:
The timeout is activated by command.
If then a so-called timeout event takes place (pause between two
accesses to the module is greater than the allowed timeout time)
the following happens:
- All outputs are switched off.
- The timeout status goes to "2".
- The timeout LED turns on (for modules that have such a status).
Further accesses to the outputs are then still possible, but the
timeout is no longer active. Not again until it has been
reactivated.
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"auto reactivate" Timeout
This is a timeout mode implemented since 2021 that
automatically re-enables the timeout after the timeout event
occurs.
Procedure for the timeout command:
The timeout is activated by command.
If then a so-called timeout event occurs (pause between two
accesses to the module is greater than the allowed timeout time)
the following happens:
- All outputs are switched off.
- The timeout status goes to "4".
- The timeout LED turns on (for modules that have such a status).
Further accesses to the outputs are then still possible. AND the
timeout is still active. If the timeout time is exceeded again, the
outputs are switched off again.
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"secure outputs" Timeout
This is a timeout mode implemented since 2021 that prevents
write access to the outputs after the timeout event has occurred.
This ensures that the software must first restore the outputs to a
"safe" state because the module's timeout mechanism has
changed the outputs to predefined values.
Procedure for the timeout command:
The timeout is activated by command.
If then a so-called timeout event takes place(pause between two
accesses to the module is greater than the allowed timeout time)
the following happens:
- All outputs are switched off.
- The timeout status goes to "6".
- The timeout LED turns on (for modules that have such a status).
Further access to the outputs is NOT possible. Only after
reactivating the timeout or deactivating the timeout the outputs
can be written.
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Definition
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT, cmd, par1, par2);

Parameter
handle=This is the handle of an open module
cmd = function to be executed
par1 = value passed to the function
par2 = value passed to the function
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5.5.1.1. DapiSpecialTimeoutSetValueSec

Description
This command is used to set the timeout time.
Definition
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT, cmd, par1, par2);

Parameter
cmd = DAPI_SPECIAL_TIMEOUT_SET_VALUE_SEC
par1 = seconds [s]
par2 = milliseconds [100ms] (value 6 = 600ms)
Comment
The permissible value range of the time specification is between
min. 0,1 seconds and max. 6553 seconds.
Programming example
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT,
DAPI_SPECIAL_TIMEOUT_SET_VALUE_SEC, 3, 7);
//The time of the timeout is set to 3.7sec.
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5.5.1.2. DapiSpecialTimeoutActivate

Description
This command activates the "normal" timeout.
After the timeout event,.
- ..all outputs are switched off
- ..the timeout status is set to "2
- ..the timeout LED is switched on (for modules that have such a
status)
Further accesses to the outputs are then still possible, but the
timeout is no longer active.
Not again until it has been reactivated.
Definition
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT, cmd, 0, 0);

Parameter
cmd = DAPI_SPECIAL_TIMEOUT_ACTIVATE
Programming example
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT,
DAPI_SPECIAL_TIMEOUT_ACTIVATE, 0, 0);
//The timeout is activated.
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5.5.1.3. DapiSpecialTimeoutActivateAutoReactivate

Description
This command activates the "auto reactivate" timeout.
In this mode, the timeout is automatically reactivated after the
timeout event.
After the timeout event.
- ..all outputs are switched off
- ..the timeout status is set to "4
- ..the timeout LED is switched on (for modules that have such a
status)
Further accesses to the outputs are then still possible AND the
timeout is still active.
If the timeout time is exceeded again, the outputs are switched
off again.
Definition
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT, cmd, 0, 0);

Parameter
cmd = DAPI_SPECIAL_TIMEOUT_ACTIVATE_AUTO_REACTIVATE
Programmierbeispiel
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT,
DAPI_SPECIAL_TIMEOUT_ACTIVATE_AUTO_REACTIVATE, 0, 0);
//The "auto reactivate" timeout is activated.
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5.5.1.4. DapiSpecialTimeoutActivateSecureOutputs

Description
This command activates the "secure" timeout.
In this mode, write access to the outputs is prevented after a
timeout event.
This ensures that the software must first restore a "safe" state of
the outputs,
because the module's timeout mechanism has changed the
outputs to predefined values.
After the timeout event, ..
- .. all outputs switched off
- ..the timeout status is set to "6"
- ..the timeout LED is switched on (for modules that have such a
status)
Further access to the outputs is NOT possible. Only after
reactivating the
Timeouts or deactivation of the timeout can be written to the
outputs
Definition
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT, cmd, 0, 0);

Parameter
cmd = DAPI_SPECIAL_TIMEOUT_ACTIVATE_SECURE_OUTPUTS
Programmierbeispiel
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT,
DAPI_SPECIAL_TIMEOUT_ACTIVATE_SECURE_OUTPUTS, 0, 0);
//Der "secure" Timeout wird aktiviert.
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5.5.1.5. DapiSpecialTimeoutDeactivate

Description
This command deactivates the timeout.
Definition
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT, cmd, 0, 0);

Parameter
cmd = DAPI_SPECIAL_TIMEOUT_DEACTIVATE
Programming example
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT,
DAPI_SPECIAL_TIMEOUT_DEACTIVATE, 0, 0);
//The timeout is deactivated.
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5.5.1.6. DapiSpecialTimeoutGetStatus

Description
This command is used to read the timeout status.
Definition
ULONG
DapiSpecialCommand(handle,
DAPI_SPECIAL_CMD_TIMEOUT,
DAPI_SPECIAL_TIMEOUT_GET_STATUS, 0, 0);

Parameter
cmd = DAPI_SPECIAL_TIMEOUT_GET_STATUS
Return-Wert
Return = 0 (Timeout is disabled)
Values for the "normal" timeout
Return = 1 (Timeout "normal" is activated)
Return = 2 (timeout "normal" has occurred)
Values for the "auto reactivate" timeout
Return = 3 (Timeout "auto reactivate" is activated)
Return = 4 (auto reactivate timeout has occurred one or more
times)
Values for the "secure" timeout
Return = 5 (Timeout "secure" is activated)
Return = 6 (Timout "secure" has taken place. In this status,
writing to the outputs is prevented).
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Programming example
unsigned long status = DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT,
DAPI_SPECIAL_TIMEOUT_GET_STATUS, 0, 0);
printf("Status = %lu\n", status);
//query of timeout status with output.
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5.5.1.7. DapiSpecialTimeoutDoValueMaskWRSet32

Description
This command determines the outputs to be set during a
timeout.
Definition
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT, cmd, ch, par2);

Parameter
cmd = DAPI_SPECIAL_TIMEOUT_DO_VALUE_MASK_WR_SET32
ch = Specifies the number of the output from which writing
should start (0, 32, 64, ..)
par2 = [32 Bit] Specifies the outputs which are to be activated at
a timeout
Programming example
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT,
DAPI_SPECIAL_TIMEOUT_DO_VALUE_MASK_WR_SET32, 0, 0xff);
//The first 8 relays are switched on in case of timeout.
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5.5.1.8. DapiSpecialTimeoutDoValueMaskRDSet32

Description
This command serves to read out the transferred values.
Definition
ULONG DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT, cmd, 0, 0);

Parameter
cmd = DAPI_SPECIAL_TIMEOUT_DO_VALUE_MASK_RD_SET32
Return-Value
[32 Bit] Value passed to the SET command
Programming example
long value = DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT,
DAPI_SPECIAL_TIMEOUT_DO_VALUE_MASK_RD_SET32, 0, 0);
printf("%0x\n", value);
//The value passed to the SET command is read out and displayed.
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5.5.1.9. DapiSpecialTimeoutDoValueMaskWRClr32

Description
This command determines the outputs that should be switched
off during a timeout.
Definition
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT, cmd, ch, par2);

Parameter
cmd = DAPI_SPECIAL_TIMEOUT_DO_VALUE_MASK_WR_CLR32
ch = Specifies the number of the output from which writing
should start (0, 32, 64, ..)
par2 = [32 Bit] Specifies the outputs to be deactivated in case of
a timeout
Programming example
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT,
DAPI_SPECIAL_TIMEOUT_DO_VALUE_MASK_WR_CLR32, 0, 0xff);
//The first 8 relays are switched off.
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5.5.1.10. DapiSpecialTimeoutDoValueMaskRDClr32

Description
This command serves to read out the transferred values.
Definition
ULONG DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT, cmd, 0, 0);

Parameter
cmd = DAPI_SPECIAL_TIMEOUT_DO_VALUE_MASK_RD_CLR32
Return-Value
[32 Bit] Value passed to the CLR command (in decimal)
Programming example
long value = DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT,
DAPI_SPECIAL_TIMEOUT_DO_VALUE_MASK_RD_CLR32, 0, 0);
printf("%0x\n", value);
//The value passed to the CLR command is read and displayed.
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5.5.1.11. DapiSpecialTimeoutDoValueLoadDefault

Description
Resets the SET and CLR values to the default value.
(SET-Value = 0, CLR-Value = FFFFFFFF)
Definition
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT, cmd, 0, 0);

Parameter
cmd = DAPI_SPECIAL_TIMEOUT_DO_VALUE_LOAD_DEFAULT
Programming example
DapiSpecialCommand(handle, DAPI_SPECIAL_CMD_TIMEOUT,
DAPI_SPECIAL_TIMEOUT_DO_VALUE_LOAD_DEFAULT, 0, 0);
//SET- and CRL- values are set to the default value.
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5.6. Test functions

5.6.1. DapiPing

Description
This command checks the connection of an opened module.
Definition
ULONG DapiPing(ULONG handle, ULONG value);

Parameters
handle=This is the handle of an opened module
value=Given test value, taking values in 0-255 (8-Bit), to the
module
Return value
The test value passed with "value" must return here
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5.7. Register write commands

5.7.1. DapiWriteByte

Description
This command performs a direct register write command to the
module.
Definition
void DapiWriteByte(ULONG handle, ULONG adress, ULONG value);

Parameters
handle=This is the handle of an opened module
adress=Address to be accessed
value=Specifies the data value that is to be written (8 bits)
Return value
None
Remarks
This should only be used by experienced programmers. A directly
access to every available register is possible.
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5.7.2. DapiWriteWord

Description
This command performs a direct register write command to the
module.
Definition
void DapiWriteWord(ULONG handle, ULONG adress, ULONG value);

Parameters
handle=This is the handle of an opened module
adress=Address to be accessed
value=Specifies the data value to be written (16 bits)
Return value
None
Remarks
This should only be used by experienced programmers. A directly
access to every available register is possible.
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5.7.3. DapiWriteLong

Description
This command performs a direct register write command to the
module.
Definition
void DapiWriteLong(ULONG handle, ULONG adress, ULONG value);

Parameters
handle=This is the handle of an opened module
adress=Address to be accessed
value=Specifies the data value to be written (32 bits)
Return value
None
Remarks
This should only be used by experienced programmers. A directly
access to every available register is possible.
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5.7.4. DapiWriteLongLong

Description
This command performs a direct register write command to the
module.
Definition
void DapiWriteLongLong(ULONG handle, ULONG adress, ULONGLONG value);

Parameters
handle=This is the handle of an opened module
adress=Address to be accessed
value=Specifies the data value that is to be written (64 bits)
Return value
None
Remarks
This should only be used by experienced programmers. A directly
access to every available register is possible.
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5.8. Register read commands

5.8.1. DapiReadByte

Description
This command performs a direct register read command to the
module.
Definition
ULONG DapiReadByte(ULONG handle, ULONG adress);

Parameters
handle=This is the handle of an opened module
adress=Address to be accessed
Return value
Contents of register-to-read (8 bits)
Remarks
This should only be used by experienced programmers. A directly
access to every available register is possible.
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5.8.2. DapiReadWord

Description
This command performs a direct register read command to the
module.
Definition
ULONG DapiReadWord(ULONG handle, ULONG adress);

Parameters
handle=This is the handle of an opened module
adress=Address to be accessed
Return value
Contents of register-to-read (16 bit)
Remarks
This should only be used by experienced programmers. A directly
access to every available register is possible.
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5.8.3. DapiReadLong

Description
This command performs a direct register read command to the
module.
Definition
ULONG DapiReadLong(ULONG handle, ULONG adress);

Parameters
handle=This is the handle of an opened module
adress=Address to be accessed
Return value
Contents of register-to-read (32 bit)
Remarks
This should only be used by experienced programmers. A directly
access to every available register is possible.
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5.8.4. DapiReadLongLong

Description
This command performs a direct register read command to the
module.
Definition
ULONGLONG DapiReadLongLong(ULONG handle, ULONG adress);

Parameters
handle=This is the handle of an opened module
adress=Address to be accessed
Return value
Contents of register-to-read (64 bit)
Remarks
This should only be used by experienced programmers. A directly
access to every available register is possible.

DELIB API Reference | Seite 232

5.9. DELIB Overview table
Command

Available for

DAPI_SPECIAL_CMD_SET_DIR_DX_1

USB-MINI-TTL8

DAPI_SPECIAL_CMD_SET_DIR_DX_8

USB-MINI-TTL8
USB-TTL32
USB-TTL64
ETH-TTL64

DAPI_SPECIAL_CMD_GET_DIR_DX_1

is not supported

DAPI_SPECIAL_CMD_GET_DIR_DX_8

is not supported

Command

Available for

Does not
for

work

DAPI_SPECIAL_CMD_TIMEOUT

ETH-TTL64

USB-Mini-Stick

DAPI_SPECIAL_TIMEOUT_DO_VALUE_

ETH-RELAIS8

MASK_WR_SET32

USB-RELAIS8

DAPI_SPECIAL_TIMEOUT_DO_VALUE_

RO-SERIE

MASK_RD_SET32

BS-SERIE

DAPI_SPECIAL_TIMEOUT_DO_VALUE_

NET-SERIE

MASK_WR_CLR32

USB-TTL-64

DAPI_SPECIAL_TIMEOUT_DO_VALUE_
MASK_RD_CLR32
DAPI_SPECIAL_TIMEOUT_DO_VALUE_
LOAD_DEFAULT
DAPI_SPECIAL_TIMEOUT_SET_VALUE_S
EC
DAPI_SPECIAL_TIMEOUT_ACTIVATE

all modules

DAPI_SPECIAL_TIMEOUT_DEACTIVATE
DAPI_SPECIAL_TIMEOUT_GET_STATUS
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Command

St art er St art er R O
USB* 1

DAPI_SPECIAL_COUNTER_

E T H* 2

BS

NE T

Ot her

Series Series Series

x

LATCH_ALL
DAPI_SPECIAL_COUNTER_

x

LATCH_ALL_WITH_RESET
DapiDOSet1_WithTimer

x

DAPI_SPECIAL_CMD_SW_FIFO

x

DAPI_SPECIAL_SW_FIFO_INIT_
AND_CLEAR
...
DAPI_SPECIAL_SW_FIFO_
IO_DEACTIVATE
DAPI_SPECIAL_CMD_AD

x

DAPI_SPECIAL_RO_AD_
FIFO_ACTIVATE
...
DAPI_SPECIAL_RO_AD_
FIFO_INIT

*1: USB-OPTOIN8, USB-Mini-Stick, USB-TTL-64
*2: ETH-TTL64, ETH-OPTOIN8, ETH-RELAIS8
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Command

DAPI_SPECIAL_DI_FF_FILTER

St art er St art er R O

BS

USB* 1 E T H* 2

Series Series

Series

NE T

Ot her

5-255 1-255 1-255 1-255 1-255

DAPI_SPECIAL_DI_FF_FILTER_
VALUE_SET
DAPI_SPECIAL_DI_FF_FILTER_
VALUE_GET
DAPI_SPECIAL_DI_FILTER

x

DAPI_SPECIAL_DI_FILTER_

0,

0,

0,

0,

1-254 1-254 1-254 1-254

VALUE_SET
DAPI_SPECIAL_DI_FILTER_
VALUE_GET
DAPI_SPECIAL_CMD_GET_

x

x

x

x

INTERNAL_STATISTIC

*1: USB-OPTOIN8, USB-Mini-Stick, USB-TTL-64
*2: ETH-TTL64, ETH-OPTOIN8, ETH-RELAIS8
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Appendix

VI
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6. Appendix
6.1. Revisions
Rev 3.00
Rev 2.02
Rev 2.01

Rev 2.00

DEDITEC Design Update
Added index
Added chapter "Firmware
update" and "Integration of the
DELIB"
First DEDITEC issue
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6.2. Copyrights and trademarks
Linux is registered trade-mark of Linus Torvalds.
Windows CE is registered trade-mark of Microsoft Corporation.
USB is registered trade-mark of USB Implementers Forum Inc.
LabVIEW is registered trade-mark of National Instruments.
Intel is registered trade-mark of Intel Corporation
AMD is registered trade-mark of Advanced Micro Devices, Inc.
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